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“Grateful smiles were evident upon the faces of families receiving gifts from the angel tree.”

- Christmas donations

	As of January 1 , 2008 the national minimum wage is $5.85
	In 2007, the national poverty guideline for a family of 4 was 

$20,650


Board of Directors

	Elizabeth DeRosa, President: I have received a Bachelors and Masters Degree in social work from East Carolina University and Temple University and have worked in shelter settings as a residential counselor, case manager and social service director. My professional career has been spent working with and for people that are homeless. I am currently a member of The National Alliance to End Homelessness and The National Coalition for the Homeless. When I am not working on Clifford’s Gift I enjoy spending time with my family, playing basketball and reading.

	James Clifford, Jr., Member:  Jamie has spent his professional career in the financial services industry and lives with his family in Charleston, South Carolina. He has been involved with Crises Ministries serving food to the areas less fortunate. In 2002 he established The Alex Fund which provides direct cash donations to the Medical University of Charleston with proceeds benefiting The Pediatric Heart Center. Jamie graduated from The University of Alabama with a degree in Business Administration. Jamie is the author of 3 published books and is affiliated with numerous coin collection associations.

	Catherine Wells, Secretary: Rosie started her own company in 2002 that encompasses bookkeeping and tax preparations for local businesses in Charleston, South Carolina. She is currently responsible for 23 companies. She also works alongside her husband on another owned business that includes home remodeling and building custom closets. In March of this year she will begin volunteering by using her skills to prepare tax return for the state of South Carolina for people that need assistance. Rosie is expecting her first child in September.

	Kristine Lilly, Member: Kristine has been a member of the United States Women’s National Soccer Team for the past 20 years. She has won 2 Olympic Gold Medals and 2 World Cup Championships. In 2005 Kristine teamed up with The Special Olympics to host an annual fundraiser dinner called The Lilly Awards to recognize extraordinary women in the state of Connecticut and help raise money for Special Olympics. She is currently a board member for TRIAD TRUST which provides educational hope and AIDS awareness to the people of Africa. She graduated from The University of North Carolina with a degree in communications. She lives in Brookline, MA with her husband and they are expecting their first child in July.

	Frank DeRosa, Member: Frank has spent his professional career in the field of human resources. He has worked for Mars, Inc., PricewaterhouseCoopers, Wachovia and Sears. He has been involved in raising money for Leukemia & Lymphoma research and has been an active contributor to the Untied Way. He is a graduate of The Catholic university of America and earned his Masters in Business Administration from Kennesaw State University. In his spare time Frank enjoys running, music and traveling.


	“I thank God so much for you. This car is such a blessing to me”.

- individual who was the recipient of a used vehicle

	“Grateful smiles were evident upon the faces of families receiving gifts from the angel tree.”

- Christmas donations 

	“You made a difference this year for a family that has had a rough year”
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If you are interested in supporting Clifford's Gift please take a few minutes and complete the form and mail back to me.  ALL DONATIONS ARE TAX DEDUCTIBLE UNDER SECTION 170 OF THE INTERNAL REVENUE CODE.





I thank you in advance for your support and taking the time to learn about Clifford’s Gift. 





Clifford’s Gift Donation form                	EIN # 20-2078649


Name:                                	________________________________________ 


Address:                            	________________________________________


City:				________________________________________


State:				________________________________________


Zip code:			________________________________________


Telephone Number:          	________________________________________


Financial Contribution: (checks payable to Clifford’s Gift)


                                         	$_______________________________________


E-mail Address                   	________________________________________


 


As of January 1, 2008, the national minimum wage is $5.85�
In 2007, the national poverty guideline for a family of 4 was  $20,650�
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“You made a difference this year for a family that has had a rough year.” – Benefactor


“I thank God so much for you. This car is such a blessing to me.”  - Benefactor




















Our Mission:


Our mission is to provide a comprehensive response to the homelessness problem and to provide numerous supportive services through community outreach and awareness. As President of Clifford’s Gift, I strongly believe that Clifford’s Gift, with your help, can make a difference in our communities. The sole purpose of this organization is to help those in need. People are homeless for so many different reasons and the numbers continue to increase every year. Clifford’s Gift is a small public charity that feels compelled to help the less fortunate. We have a simplistic approach to assist those who need it while reaping the rewards on a personal rather than financial level.








Board of Directors: 


President:	Elizabeth DeRosa, 


Members:	James Clifford Jr., Frank DeRosa, Kristine Lilly


Secretary:	Catherine Wells





Letter From Elizabeth:


Dear Family and Friends,





I would like to take this opportunity to thank each and every one of you for your generosity and much needed financial assistance in helping to fund Clifford’s Gift. I would also like to welcome individuals who are learning about Clifford’s gift for the first time. In 2006, I sent a letter explaining the company I was starting and who would benefit from its services. Over the course of the past 2½ years Clifford’s Gift has taken your kindness and used it to provide hope for people in our communities. The goal is and will always be to help individuals, children and families who are homeless or on the verge of homelessness. Clifford’s Gift is a non-profit, 501 (c)(3) corporation established for the charitable purpose of providing assistance to existing organizations working directly with people that are low income and/or homeless. 


As president of Clifford’s Gift, I understand that you are entrusting me with the responsibility of making fiscally sound decisions and I have done that to the best of my ability. I worked and will continue to work closely with the organizations that Clifford’s Gift works with to ensure that the items purchased are needed and going directly to the people they are intended to help. 


.


There is much that still needs to be accomplished and it is my hope that you will continue to support Clifford’s Gift and its mission of helping the homeless.





I thank you for your consideration and as always wish you and your families the very best!!!!!





Sincerely,





Elizabeth DeRosa


President


Clifford’s Gift








 









































from the For Which Heading list box and then click Insert.


Formatting Text Boxest wraps around it, click the Wrapping tab. If you want to format all the text boxes in an article, you must format them individually - the formatting on one text box will not apply to the others in the sequence. 


Using Linked Text for Parallel Articles


You can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.(





Your Donations at Work:


$13,003 and Still Counting…


Below are just a few of the wonderful things that Clifford’s Gift has been able to accomplish:


Purchased 3 vehicles for individuals that are homeless and working


Relief items to Hurricane Katrina victims


Numerous items, including blankets, pillows and toiletry items were donated to shelters


Christmas and Easter items were donated on behalf of children in need


Provided food and “holiday” gift certificates to food banks


And the list goes on…and on….
















































































To keep these instructions, choose Print from the File menu. Press Enter to print the template. Replace the sample text with your own text to create your newsletter.


Using Styles in This Template


To change the Style of any paragraph, select the text by positioning your cursor anywhere in the paragraph. Select a Style from the drop-down Style list at the top-left of your screen. Press Enter to accept your choice.




























































































See Page 4 to learn how to edit or replace this picture.


Jump To and Jump From - Use these styles to indicate that an article continues on another page.


Mailing Address - Use this style in a mailing label to type the destination address.


Postage - Use this style in a mailing label to type postage information.


Return Address - Use this style in a mailing label to type your address.


Picture Caption - Use this style to type a description of a picture or illustration.


Subtitle - Use this style to type sub-headings in an article.


Use PullQuote to excerpt text from the main text of a story to draw a reader’s attention to the page. See page 4 for an example.
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